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Clients	&	Profits	X	has	built-in	full-featured	media	planning,	buying,	and	tracking	
capabilities.	These	media	functions	seamlessly	integrate	with	job	tickets,	job	cost-
ing,	and	client	billing.	The	media	system	lets	you	build	detailed	broadcast,	print,	in-
teractive,	and	outdoor	media	orders	based	on	TV,	newspaper,	magazine,	and	alterna-
tive	media	buys,	as	well	as	simple	media	estimates.	Clients	&	Profits	X	keeps	a	list	
of	publications,	media	companies,	and	stations,	as	well	as	the	available	ad	sizes	and	
program	times	that	are	most	commonly	used.		By	using	these	lists,	you	can	create	
media	plans	with	little	rekeying.	In	this	chapter	you’ll	learn	about:

■		creating	lists	of	stations/programs	and	publications/ad	sizes
■		adding	broadcast	and	print	media	plans
■		adding	and	printing	media	estimates
■		making	insertion	and	broadcast	orders	automatically	from	plans	and	estimates
■ 	adding	and	printing	broadcast	orders	and	insertion	orders
■ 	tracking	materials	due	and	space	closing	dates
■		printing	media	plans,	estimates,	and	reports
■		automatically	import	media	buys	from	SmartPlus,	Strata,	and	TAPSCAN

For	help	using	any	part	of	Clients	&	Profits	X,	click	the		 		button	from	any	

window	to	open	the	on-line	user	guide.	This	web-based	user	guide	features	

step-by-step	instructions,	explanations,	tips,	demonstrations,	and	links	to	

FAQs,	tech	notes,	and	tutorials	from	www.cnp-x.com/support.		The	web	site	is	

continually	updated,	so	it’s	more	timely	and	helpful	than	a	printed	user	guide.

Introduction
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Overview: How Clients & Profits X 
Manages Media

How Clients & Profits X Manages Media

The	media	functions	in	Clients	&	Profits	X	are	designed	to	replace	the	
database	or	spreadsheet-based	custom	systems	that	most	shops	now	use	
to	plan,	buy,	and	track	media.	It	doesn’t	try	to	replace	high-volume	media	
buying	systems	like	SmartPlus,	TAPSCAN,	or	Strata.	Instead,	it	is	designed	for	
shops	that	buy	a	relatively	small	amount	of	media—and	whose	planning	and	
analytical	needs	are	simple.		

Although	it	can	create	broadcast	buys,	Clients	&	Profits	X	is	optimized	
for	print	media	planning,	buying,	and	tracking.	It	works	best	in	shops	that	
primarily	buy	business-to-business	media,	instead	of	consumer	broadcast	
media.	That’s	because	it	doesn’t	import	and	process	ratings	data	from	media	
services	like	Nielsen	and	Arbitron.	Instead,	you’ll	set	up	and	maintain	your	
own	station,	publication,	program,	ad	size,	and	rate	information.	It’s	a	big	job	
to	maintain	these	files,	so	it’s	only	practical	if	the	number	of	media	plans	you	
do	is	small.

There	are	two	ways	to	buy	media	with	Clients	&	Profits:	media	plans	and	
media	estimates.	Media	plans	are	elaborate	and	automatically	lookup	ad	
rates,	while	media	estimates	are	simple	and	added	manually.	They	both	print	
a	professional-looking	report	for	your	client	to	sign,	authorizing	your	media	
buys.	Otherwise,	they	have	different	purposes.

Media estimates vs. media plans

Media	plans	use	the	station	and	publication	data	(which	you’ll	set	up)	to	
automate	the	planning	process—so	there’s	no	rekeying	information	from	the	
rate	table	to	the	media	plan.	Media	estimates	skip	the	planning	process—in-
stead,	you’ll	simply	type	in	the	details	about	the	media	buy	each	time	you	
need	one.	There	are	also	specially-designed	media	windows	and	forms	for	
broadcast	and	print	plans.

Media	estimates,	however,	are	free-form.	You	can	customize	the	information	
on	media	estimates	as	needed.	Every	media	estimate	you	do	could	conceiv-
ably	have	different	labels	and	headings,	depending	on	the	different	kinds	of	
media	that	you	buy.	Since	there’s	less	to	set	up,	creating	a	media	estimate	is	
much	faster	than	creating	a	media	plan	(which	may	be	reason	enough	to	use	
them).

If	you	don’t	need	a	planning	system,	or	use	another	system	(like	a	spread-
sheet	or	Tapscan)	to	plan	your	buys,	consider	using	only	media	estimates.	
Once	the	media	estimate	is	added,	it	can	easily	create	insertion	orders	
automatically	without	rekeying.	This	saves	lots	of	time	and	effort,	as	well	as	
keeps	your	insertion	orders	more	accurate.		

Publications, ad sizes, and contract rates

The	Publications/Ad	Sizes/Contract	Rates	window	lists	the	publications	
you	most	commonly	use,	as	well	as	the	various	ad	sizes	available	for	each	
publication.	Each	publication	can	have	dozens	of	ad	sizes,	each	with	details	
about	its	position,	commission,	space	close,	and	materials	close	dates.		These	
production	specifications	are	carried	over	to	the	media	plan	and	to	media	

reports,	for	easy	reference.	Each	publication	ad	size	has	a	standard	rate.	In	
addition,	you	can	set	up	contract	rates	for	each	client.	This	option	lets	you	
specify	special	ad	sizes	and	rates	that	are	only	available	to	a	client.	So	when	a	
print	buy	is	added	for	a	particular	publication,	the	client’s	special	rate	will	be	
used	instead.

Stations, programs, and contract rates

The	Stations/Programs/Contract	Rates	window	lists	the	stations	you	most	
commonly	use,	as	well	as	the	programs/times	for	each	station.	You	can	enter	
a	virtually	unlimited	number	of	stations.	And	each	station	can	have	hundreds	
of	different	programs	and	times.	A	station	can	have	a	set	of	programs,	each	
with	its	rating	and	a	standard	cost.	Or,	you	can	set	up	contract	rates	for	spe-
cific	programs	and	clients.	Each	client	can	have	its	own	table	of	contract	rates	
for	each	station.	So	when	a	broadcast	buy	is	added	for	a	particular	station,	the	
client’s	special	contract	rate	will	be	used	automatically.

Insertion orders, broadcast orders

Insertion	orders	can	be	added	manually	into	the	Insertion	Order	window,	or	
created	automatically	from	print	media	plans	or	media	estimates.	When	creat-
ed	automatically,	there’s	no	rekeying—the	media	buy’s	publication,	ad	name,	
position,	cost,	and	other	details	are	copied	directly	to	the	insertion	order.	You	
can	make	insertion	orders	from	media	plans	and	estimates	on	demand;	the	
entire	process	takes	less	than	a	minute.	Once	the	insertion	order	is	saved,	you	
can	review	it,	make	changes,	then	print	it	for	the	publication.		

Broadcast	orders	can	be	added	manually	into	the	Broadcast	Order	window,	or	
created	automatically	from	broadcast	media	plans.	When	created	automati-
cally,	the	media	buy’s	station,	rating,	number	of	spots,	and	other	details	are	
copied	directly	to	the	broadcast	order.	Once	the	broadcast	order	is	saved,	you	
can	review	it,	make	changes,	then	print	it	for	the	station.		

Interactive orders, outdoor orders

Clients	&	Profits	X	can	print	interactive	orders	specifically	designed	to	buy	
on-line	advertising.	Outdoor	orders	are	designed	especially	for	buying	media	
space	on	billboards,	buildings,	and	other	out-of-home	locations.	Interactive	
and	outdoor	orders	are	added	like	print	and	broadcast	orders;	they	get	job	
numbers	and	job	tasks,	are	costed	from	vendor	invoices	added	in	Accounts	
Payable,	and	can	be	billed	in	one	step	in	Accounts	Receivable.

Media estimates

If	you	buy	mostly	print	media	(magazines	and	newspapers)	for	your	clients	
and	you’re	planning	needs	are	basic,	use	a	media	estimate.	Adding	a	media	
estimate	is	similar	to	adding	a	job:		the	media	estimate	has	a	number,	a	client,	
a	description,	and	line	items	just	like	a	job	has	tasks.

Media	estimates	are	very	customizable.	Each	media	estimate	has	five	column	
labels	(e.g.,	publication	name,	issue	date,	close	date,	ad	caption,	and	ad	size)	
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Clients & Profits X features an integrated media calendar. The calendar, which convenient-
ly appears whenever users work with media, lists upcoming space closing and material due 
dates as well as user-defined calendar “tickler” entries. These scheduled entries can be 
automatically e-mailed to media planners, buyers, and vendors. 

The names, addresses, and phone numbers of the most commonly-used publications and 
their various ad sizes (including prices) can be set up before adding print media plans. 
The information entered for each publication and ad size is copied automatically to new 
print plans, saving time and reducing data-entry errors. The publications table can be 
updated any time as information changes.

The Stations table lists the name, address, and account details for hundreds of different 
radio, television, and cable stations. The Times/Programs table contains descriptions and 
costs of the time slots offered by each station. This information is used automatically by 
broadcast media plans, and is copied to broadcast orders. 

Simple, quick media estimates can be created for clients showing them a schedule of 
media buys for any number of publications or stations. The printed media estimate looks 
like a job estimate, and includes a client approval signature line. Insertion orders can be 
made automatically from media estimates.

Detailed broadcast media plans can be created that show scheduled radio, television, 
cable, buys, including the number of spots, rating, cost per point, and more. Broadcast 
orders can be generated directly from broadcast media plans.   

Complete print media plans can be made that show schedule ad placements for daily 
newspapers, weekly periodicals, or monthly magazines. Insertion orders can be created 
from print media plans without rekeying.

Orders can be created automatically from broadcast and print media plans. Orders can be 
placed any time using the information already saved on the media plan, saving time and 
eliminating rekeying errors. Orders are saved directly in the Media Orders table, where they 
can be proofed, printed, then billed—without retyping. 

Once insertion and broadcast orders are created from media plans, they can be easily and 
quickly billed. Orders can be pre-billed directly from the Insertion/Broadcast/Interactive/
Outdoor Orders window (choose Edit > Pre-bill) one-by-one, or billed together in batches 
by client in Accounts Receivable. Insertion and broadcast orders remember the client’s 
invoice number, so it’s easy to keep track of unbilled media.

Media accruals for work in progress are posted automatically from media billing. The net 
cost of the insertion or broadcast order is used for accrual journal entries, which update a 
special WIP accrual G/L account. When the media vendor’s invoice is entered, it reconciles 
the actual cost of the media with the accrued cost then makes the automatic reversing 
entry.

In Accounts Payable, the actual number of broadcast spots or ad placements is reconciled 
with the planned spots from the insertion or broadcast order. Each order keeps its own 
running balance of planned cost vs. actual cost, making it easy to bill clients accurately.

The built-in Media Link imports broadcast orders from MRP’s SmartPlus, TAPSCAN, and 
Strata. Imported buys appear automatically in the Broadcast Orders window, where they 
can be billed like other broadcast orders. A “standard media interface” lets any other 
media buying system export buys to Clients & Profits X using a simple-to-program import 
file format.

Media Calendar

Publications/ad sizes/media 
companies tables

Stations/programs tables

Media estimates

Broadcast media plans

Print media plans

Insertion orders, broadcast 
orders

Media billing

Media WIP accounting

Media reconciliation

Importing SmartPlus, TAP-
SCAN, 
and Strata media buys

Media Features

Feature How it works, how it’s used
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Overview (con’t)

How Clients & Profits X Manages Media

that	you	can	change	for	different	kinds	of	media	buys.	You	can	enter	a	long	
description,	a	campaign	code	(for	post-buy	tracking),	a	standard	disclaimer,	
and	up	to	three	approval	names.	These	details	appear	on	the	printed	media	
estimate.

Media	estimates	don’t	affect	job	tickets	until	the	insertion	orders	are	created.

Print and broadcast media 
plans

On	the	media	plan	for	a	client,	enter	
a	plan	number,	name,	and	other	
details,	then	add	separate	buys	for	
each	station	or	publication.		

Print	media	plans	can	be	set	up	for	
monthly,	weekly,	or	daily	publica-
tions.		For	magazines,	these	periods	
can	represent	months	during	the	
year.	For	newspapers,	they	can	rep-
resent	different	weeks.	Since	these	
periods	are	customizable,	they	can	
handle	any	kind	of	time	range;	how-
ever,	the	periods	you	enter	apply	to	
every	buy	on	the	media	plan.

Adding	media	buys	is	like	adding	
tasks	to	jobs.	You’ll	enter	the	pub-
lication	or	station	code,	which	behaves	like	the	task	code.	You	can	see	the	
publication’s	ad	sizes	(or	the	station’s	programs/times)	from	a	pop-up	Lookup	
List.	Double-clicking	on	an	ad	size	(or	program)	enters	it	onto	the	media	plan.	
Most	importantly,	the	rate	is	copied	to	the	media	buy	automatically.	For	
broadcast	buys,	you’ll	enter	the	number	of	times	the	spot	will	run—and	the	
total	cost	and	rating	points	are	calculated	automatically.		You	can	add	many	
different	buys	for	many	different	publications	(or	stations)	onto	the	same	
media	plan.

When	the	media	plan	is	printed,	the	buys	you’ve	entered	are	grouped	
together	by	publication	(or	station).	

Media billing

There	are	two	ways	to	bill	media	in	Clients	&	Profits:	pre-billing	an	individual	
insertion	(or	broadcast)	order	or	summary	billing	one	or	more	orders.		

An	insertion	or	broadcast	order	can	be	easily	and	quickly	pre-billed	directly	
from	the	Insertion/Broadcast	Order	window.	It’s	simple:		find	the	order,	then	
choose	Pre-bill	Order	from	the	Edit	menu.	The	order’s	details	are	copied	in-
stantly	to	a	special	pre-billing	invoice.	The	invoice	is	numbered	automatical-
ly.	You	can	see	pre-bill	invoices	on	the	proof	list,	make	any	needed	changes,	
then	post	them.	Once	posted,	the	pre-bill	invoice	information	updates	the	

insertion	or	broadcast	order	so	it	can’t	be	billed	twice.

It’s	also	easy	to	bill	many	insertion	or	broadcast	orders	at	once.	The	media	
billing	option	in	Accounts	Receivable	displays	a	window	listing	the	client’s	
unbilled	insertion	or	broadcast	orders.	You	can	select	one,	many,	or	all	orders	
for	billing	by	clicking	on	the	checkbox	next	to	the	order	line	item.		The	media	
billing	invoice	has	a	different	layout	than	regular	job	billings;	it	shows	the	

publication	or	station,	ad	name,	ad	
size,	issue	date,	and	gross	cost.

Media preferences

Your	media	preferences	let	you	
standardize	some	of	the	information	
seen	on	insertion	and	broadcast	
orders.	This	information,	such	as	the	
disclaimer,	logo,	and	print	copies	
are	copied	to	orders	automatically	
to	save	time.	You	can	even	order	
media	under	a	different	name	and	
address,	which	is	ideal	for	in-house	
agencies.	You	can	customize	how	
insertion	and	broadcast	orders	are	
automatically	numbered,	including	
entering	the	next	order	number.	

Media and the General Ledger

There	is	no	direct	link	between	media	plans	and	the	General	Ledger.	Adding	a	
media	plan	doesn’t	affect	jobs.	The	job	ticket	is	updated	when	an	insertion	or-
der	is	created	from	a	media	plan;	the	job	task’s	Net	and	Gross	total	increases	
to	show	that	you’ve	ordered	something.	Insertion	orders,	like	purchase	orders,	
don’t	affect	the	General	Ledger	either.	The	General	Ledger	is	only	affected	
when	the	station	or	publication’s	invoice	arrives	or	the	insertion	is	billed.

You	can	account	for	insertion	orders	made	during	the	month	with	general	
journal	entries	to	a	media	G/L	account.	A	list	of	insertion	orders	added	during	
the	month	can	be	printed	from	the	Media	Reports	window;	this	total	would	be	
added	as	a	journal	entry,	then	reversed	next	month.	The	difference	between	
the	month’s	insertions	is	your	actual	media	cost.
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The Media menu

1  The Media Calendar displays 
all of the month’s space clos-
ings (from media plans and es-
timates) and material due dates 
(from insertion and broadcast 
orders).  

2  Media Briefs are like creative 
briefs for media plans and 
estimates. They organize the 
objectives, goals, and budgets 
for a client’s media buys.  

3  Media Estimates are simple 
summaries of the media buys 
that you place for a variety of 
publications and a range of 
dates. It’s the quickest way to 
show a client all of the buys you 
plan to make on their behalf.  

4  Broadcast Media Plans are 
used to make detailed plans of 
spot tv, cable, and radio ads 

for a client media campaign. 
Broadcast plans can be created 
for any broadcast month and 
can contain buys for dozens of 
different stations.   

5  Print Media Plans are used 
to make detailed plans for 
space buys in magazines, news-
papers, billboards, and other 
print media. Print plans can be 
created by day, week, month, 
or year.

6  Insertion/Broadcast Orders 
take buy details from estimates 
and plans to create orders for 
media vendors. Media orders 
can also be added directly, 
bypassing the media estimate 
and media plan steps.  They 
update jobs and tasks, and are 
the start of the job costing and 
billing process. 
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7  The Media Traffic window 
lists space reservation deadlines 
and dates for materials due by 
week for the next four weeks. 

8  The stations table lists 
media stations and their times 
and programs. Both are used 
on broadcast media plans and 
orders.

9  The publications table lists 
media publications and their 
space buy details (such as ad 
size). Both are used on print 
media plans, media estimates, 
and insertion orders.

10  The optional Media Billing 
Goals window lets you plan 
a year’s worth of billings by 
type of media (e.g., broadcast, 
interactive, etc.) for all clients. 
Media analysis reports will 
compare actual media billing 
with these goals.
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Media Work Flow

Media Work Flow

TV / RADIO / CABLE

1.  
Add stations, programs, and cli-

ent contract rates

2.
Add broadcast media plan

3.
Add media buys for broadcast 

plan

4.
Print the broadcast media plan 

for review

5.
Make revisions, then print the 
broadcast media plan for client 

approval

6.
Print station’s broadcast work-

sheet

7.
Make broadcast orders

8.
Pre-bill the broadcast orders

or create a Media billing

MAGAZINES / NEWSPAPERS

1.  
Add publications, ad sizes, and client 

contract rates

2.
Add print media plan

3.
Add space buys for print plan

4.
Print the print media plan for review

5.
Make revisions, then print the 

print media plan for client approval

6.
Make insertion orders

7.
Pre-bill insertion orders or

create Media billing
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INTERACTIVE

1.  
Add media companies and stan-

dard, client contract rates

2.
Add interactive media estimate

3.
Print the interactive media esti-

mate for client review

4.

Make revisions, then print the 
final media estimate for client 

approval

5.
Generate the interactive media 

orders from the estimate

6.
Pre-bill the interactive orders

or create a media billing

OUTDOOR

1.  
Add media companies and stan-

dard, client contract rates

2.
Add outdoor media estimate

3.
Print the outdoor media estimate 

for client review

4.

Make revisions, then print the 
final media estimate for client 

approval

5.
Generate the outdoor media 

orders from the estimate

6.
Pre-bill the outdoor orders
or create a media billing
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Media Calendar

Media Calendar

1  Use the calendar pop-up 
menu to choose which calendar 
to add the media calendar entry 
for.  

2  Date and time tells when the 
media event will happen.

3  Location describes where 
the media calendar entry will 
happen.

4  The action/event is a short 
description of the media event.  
It will appear on the Media 
Calendar window, so it should 
be meaningful to other users.  

5  Use the description field to 
further describe the details of 
the media action/event.

6  You can determine the 
importance/urgency level of the 
media event using the priority 
pop-up menu. In the Day-at-a-
Glance Calendar, each media 
event will be designated as 
high, normal, or low priority 
with a colored icon (red for 
high, yellow for normal, and 
green for low) so users can eas-
ily see the priority level.
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Media calendar entries keep track of important media dates. Tickler entries can be 
scheduled for any future date and can be automatically e-mailed when they’re due.

The	Media	Calendar	window	is	a	useful	tool	for	managing	media.		Media	calendar	entries	can	be	entered	at	any	time	
to		help	users	remember	important	media-related	dates,	such	as	client	presentations,	vendor	meetings,	confer-
ences,	and	planning	sessions.		Double-clicking	on	any	date	in	the	Media	Calendar	window	will	open	the	Day-at-
a-Glance	window.		This	special	window	shows	a	listing	of	all	the	calendar	entries	for	the	selected	date	with	their	
priority	level	conveniently	color	coded.		To	view	all	the	details	of	a	calendar	entry,	just	double-click	on	it.		

7 Specify an automatic lead 
time warning e-mail in days 
prior to a media action/event.

8  A media calendar entry can 
be added for any client.

9  A status can be assigned to 
the media calendar entry.  

10  The added by field shows 
the initials of the person who 
added this media calendar 
entry.
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1  Use these toolbar buttons 
to scroll through the previous  
and next months of the media 
calendar.

2   You can create a media 
calendar entry by clicking on 
the add button.   

3  To get a hard-copy printout 
of the media calendar, click on 
the print calendar button.

4  Enter a date here to find 
media calendar entries for a 
specific date. To jump to today’s 

media calendar entries, click on 
the show today link.

5  Use the month and year 
pop-up menus to choose which 
month of the media calendar 
you want to view.  The media 
calendar allows you to create 
entries for three years.

6  Click on a date in the Media 
Calendar window to open the 
Day-at-a-Glance Calendar. This 
window will allow you to view 
the details of a media calen-
dar entry, as well as add new 
entries.

The Media Calendar keeps your media staff informed by letting them see at-a-glance 
what important media events are fast approaching.  
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Media Briefs (Campaigns)

Media Briefs (Campaigns)

A	media	brief	is	a	worksheet	that	the	media	department	can	use	to	define	and	document	the	media	process	your	
agency	follows	to	purchase	media.		It	helps	outline	what	needs	to	be	accomplished	by	the	media	purchased;	they	fo-
cus	on	what	needs	to	be	done	to	start	buying	media;	and	track	the	necessary,	minute	details	of	the	media	buying	pro-
cess.		The	media	brief	can	be	printed	with	all	its	important	planning	details	to	be	distributed	to	the	AEs	and	clients.			

Use media briefs to keep the media department and the AE’s on the same page about 
media planning, ordering, targeting audience, budget, etc.

1  Media briefs can be easily 
added, cloned, edited, and 
deleted. To add a new media 
brief, click on the add button. 
Or use the clone button to clone 
a media brief into a new one. 
Cloning copies all of the details  
from an existing media brief, 
then lets you edit it. To change 
the media brief’s details (i.e., 
target group, objective, media 
budget, etc.), click on the edit 
button.  Media briefs are flexi-
ble so they can be edited at any 
time. To delete a media brief, 
click on the delete button.     

2  To print media reports, click 
on the print reports button. To 
print a hard-copy printout of the 
media brief, click on the print 
brief button.

3  Click on a tab pane to switch 
between pending media briefs, 
killed media briefs, and ap-
proved media briefs.

4  To find a media brief, enter a 
client code here.  

5  Media briefs are listed in 
order by client. You can change 

the sort order by clicking on any 
of the column headings.

6  Media briefs are displayed 
with their client code, campaign 
ID number, campaign name, 
start date, end date, and status.  
Double-click on a campaign to 
view its details.  

7  The objective for a selected 
media brief appears here for 
reference.  

y
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1  Each media brief is entered 
for one client only.  

2   The campaign ID code is 
usually a combination of the 
client code and a number.

3  The campaign name should 
briefly describe the campaign.

4  The start date and end date 
note when the campaign was 
opened and when it will close.

5  The media rep is the person 
responsible for planning and 
buying this campaign’s media.

6  Campaigns can be given an 
optional AE.  Custom reports 
can analyze campaigns by AE.  

7  The added by initials are 
the person who added this 
campaign.  

8  An objective can be added 
to explain the primary goal of 
this campaign.  It appears in 
the Media Brief window so it 
should be clear and meaningful 
to other users.

9  Use the details pop-up menu 

o

Add a media brief to keep track of all your important details (i.e., target age, media 
schedule, supporting exhibits, etc.) for a campaign in one easy to find place.

p

a

to enter in the details for the 
campaigns target age, target 
gender, target occupation, 
target lifestyle, media recom-
mendations, media schedule, 
and supporting exhibits.  

10  A media budget can be 
entered for the campaign.  It is 
broken out by media type (i.e., 
broadcast, cable, radio, etc.).

11  An optional status can be 
used to track campaigns from 
start to finish using the same 
Status Table as jobs.
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The media estimate provides a simple way to show clients how and where their ads will 
be placed.  There’s no limit to how many media estimates you can add for a client.

u

f

1  Use these toolbar buttons to 
scroll through the previous and 
next media estimates.  

2  Media estimates can be eas-
ily added, cloned, edited, and 
deleted. To add a new media 
estimate, click on the add but-
ton. Or use the clone button to 
clone a media estimate into a 
new one.  Cloning copies all of 
the details and buys from an 
existing media estimate, then 
lets you edit it. To change the 
media estimate’s key details 
(i.e., client, approvals, date, 

commission, etc.), click on the 
edit button. Media estimates 
are flexible so they can be 
edited at any time. To delete 
a media estimate, click on the 
delete button.   

3  The media estimate is 
incomplete without media buys.  
The buys indicate exactly which 
ads are running on each publi-
cation. A single media estimate 
can contain one or many media 
buys from one or many different 
publications. To add a media 
buy to the media estimate, click 

on the add buy button.  Media 
buys can be deleted at any time 
before they are ordered (that 
is, an insertion order has been 
created for it). To remove a 
media buy, click on the remove 
buy button.  

4  Insertion orders can be cre-
ated automatically from your 
media estimate by clicking on 
the make order button. You can 
make an insertion order for one 
selected space buy, or for all 
space buys on the media esti-
mate. One insertion order will 
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A media estimate is added in two parts, much like adding a job ticket.  First, open the 
new media estimate, which includes the estimate number, client, campaign name, 
and description.  Next, add media buys for each time an ad will run for this estimate. 

be created for each publication.  

5  To print media reports, click 
on the print reports button.  To 
print a hard-copy printout of the 
media estimate, click on the 
print estimate button.

6  Enter a media estimate 
number here to find a media 
estimate.  Or use the find more 
link to find media estimates 
by sequence, number, client, 
description, date, or campaign.

7  Use the history pop-up menu 
to jump to a previously viewed 
media estimate.

8   A media estimate is opened 
for only one client. This would 
be the client who will be re-
sponsible for authorizing these 
media buys.

9 Media estimates are num-
bered automatically by client, 
like job tickets. The estimate 
number is the combination of 
the client number and its next 
estimate number. You can enter 
any kind of estimate number 
you like.

10   A media estimate can be 

marked as closed after its buys 
have been ordered. Placing a 
media estimate on-hold makes 
it inactive, but keeps it open for 
future use. Closed and on-hold 
orders don’t appear on media 
status lists and traffic reports.

11  Category is the media kind 
that has been selected for the 
media estimate’s vendor.  It is 
used on some media reports to 
group media estimates together.

12  The description can contain 
any kind of notes, specifica-
tions, objectives, or strategies 
that should appear on the 
printed media estimate. The 
description is changed by click-
ing on the Edit button.

13  A media estimate can 
contain dozens of individual 
buys, which represent different 
dates in which an ad will run. 
The column headings for media 
buys are customizable—each 
media estimate can have differ-
ent labels, for flexibility. They 
can be changed by clicking the 
edit button.

14  The publication code 
indicates from which magazine, 

newspaper, outdoor, or other 
media this buy is being ordered.

15  The issue date shows when 
the ad will run.

16  The ad number, caption, 
and size describe the ad space 
that will be ordered from this 
estimate. These details appear 
on the printed insertion order 
and the client’s media billing.

17  Gross cost is the amount 
you’re charging the client for 
this ad. The commission is cop-
ied from the client, and is used 
to calculate the ad’s net cost. 
Net cost is the amount you’ll 
pay the publication for the ad. 

18  If the selected media buy 
has already been ordered on an 
insertion order, the IO number, 
date, and actual order amount 
will appear here for reference.

19  Media estimates can be 
tracked from start to finish by 
status on reports. The status 
is optional, and is completely 
customizable. It is not related 
to the job production/billing 
status codes.
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Broadcast Media Plans
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Most of the information entered on a broadcast media plan is included on the printed 
broadcast plan that the client will approve.  It can be revised and reprinted many times.

u
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1  Use these toolbar buttons to 
scroll through the previous and 
next broadcast media plans.  

2  Broadcast media plans 
can be easily added, cloned, 
edited, and deleted.  To add 
a new broadcast media plan, 
click on the add button. Or 
use the clone button to clone 
a broadcast media plan into a 
new one.  Cloning copies all of 
the details and buys from an 
existing broadcast media plan, 
then lets you edit it. To change 
the broadcast media plan’s key 

details (i.e., client, approvals, 
flight dates, commission, etc.), 
click on the edit button.  Broad-
cast media plans are flexible so 
they can be edited at any time.  
To delete a broadcast media 
plan, click on the delete button.   

3  The broadcast media plan is 
incomplete without spot buys 
for times and programs.  A 
separate spot buy should be 
added for each time or program 
during which the ad will run.  
To add a broadcast buy to the 
broadcast media plan, click on 

the add buy button.  Broadcast 
buys can be deleted at any 
time before they are ordered 
(that is, a broadcast order has 
been created for it).  To remove 
a broadcast buy, click on the 
remove buy button.  

4  To print media reports, click 
on the print reports button.  
Click the print worksheet button 
to print the Broadcast Work-
sheet which shows the plan’s 
buys in detail by station and the 
total number of spots, cost, and 
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Broadcast media plans can be created for many kinds of radio, television, cable, or 
even Internet-based media buys.  A broadcast media plan is similar to a job ticket:  
it is opened for one client, has a number to track it, can be changed many times as 
needed, and printed for a client’s approval.

rating for each station and for 
the entire plan. To print a hard-
copy printout of the broad-cast 
media plan, click on the print 
plan button.

5  Broadcast orders can be 
created automatically from your 
broadcast media plan by click-
ing on the make order button.  
You can make a broadcast order 
for one selected broadcast buy, 
or for all broadcast buys on the 
broadcast media plan.  One 
broadcast order will be created 
for each station.  

6  Enter a broadcast media 
plan number here to find a 
broadcast media plan.  Or use 
the advanced search link to find 
broadcast media plans by se-
quence, number, client, name/
title, start date, or campaign.

7  Use the history pop-up menu 
to jump to a previously viewed 
broadcast media plan.

8   Each broadcast media plan 
is tracked by a media plan 
number. Media plans are num-
bered automatically by client.  
Each client has its own number-
ing sequence for easy tracking. 
A media plan’s number can’t 
be changed. Broadcast media 
plans are opened for a single 
client.  The client number will 
be copied from the media plan 
to broadcast orders and, even-
tually, to media invoices. The 
media plan’s name/title appears 
here for reference and is usually 

a brief description of the plan’s 
objective. The broadcast plan’s 
flight schedule is customizable.  
These are the days on which the 
spots will run.

9  A broadcast media plan can 
be marked as closed after its 
buys have been ordered. 

10  Placing a broadcast media 
plan on-hold makes it inactive, 
but keeps it open for future use. 
Closed and on-hold orders don’t 
appear on media status lists 
and traffic reports.  

11  The buyer initials are 
copied as the person adding 
the media plan, but can be 
changed.

12  The broadcast media plan’s 
total spots, rating, cost, and 
other summary totals appear 
here for easy reference. The 
CPP is the cost per rating point 
and the CPS is the cost per 
spot.

13  The campaign code is dis-
played here for easy reference. 
The media plan’s optional bud-
get, if entered, appears here.  

14  The broadcast media plan’s 
spot buys are listed by station. 
Each spot buy contains a sta-
tion name, the time/program 
name during which the spots 
will be running, the length of 
each spot, the number of spots, 
total rating points, and the spot 
buy’s total gross cost. Double-

clicking on a spot buy displays 
its complete details.

15  The station is who you 
bought the broadcast buy to run 
during a time or program.

16  Market shows where the 
broadcast buy’s spots will run.

17  Dates shows when the 
broadcast buy’s spots will run.

18  The time/program field 
contains the name of the time 
or program the broadcast buy 
will run.  

19  Length describes how long 
the broadcast buy’s spots will 
run.  Spots shows the number 
of times the broadcast buy will 
run during the time or program.  
Rating shows what the time or 
program’s rating is.

20  Gross/Each shows how 
much each spot run for the 
broadcast buy will cost.  

21  The status field can be used 
to track broadcast media plans. 
It appears here for reference, 
but it can be edited in the Edit 
Broadcast Media Plan window.   
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Print media plans can be created for three kinds of periods:  daily (for newspapers), 
weekly (for newspapers, journals, etc.), and monthly (for magazines).  
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1  Use these toolbar buttons to 
scroll through the previous and 
next print media plans.  

2  Print media plans can be 
easily added, cloned, edited, 
and deleted.  To add a new 
print media plan, click on the 
add button. Or use the clone 
button to clone a print media 
plan into a new one.  Cloning 
copies all of the details and 
buys from an existing print 
media plan, then lets you 
edit it. To change the print 
media plan’s key details (i.e., 

campaign, start date, end date, 
approvals, kind, etc.), click on 
the edit button.  Print media 
plans are flexible so they can be 
edited at any time.  To delete a 
print media plan, click on the 
delete button.   

3  The print media plan is 
incomplete without buys for ad 
space.  Space buys indicate 
exactly which ads are running 
on each publication during each 
of the plan’s twelve months, 
weeks, etc.  One print media 
plan can contain space buys for 

dozens of different publica-
tions, or many buys for the 
same publication.  To add a 
space buy to the print  media 
plan, click on the add buy 
button.  Space buys can be 
deleted at any time before they 
are ordered (that is, an insertion 
order has been created for it).  
To remove a space buy, click on 
the remove buy button.  

4  Insertion orders can be cre-
ated automatically from your 
print media plan by clicking on 
the make order button.  You can 
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The print media plan is incomplete without buys for ad space. One print media plan 
can contain space buys for dozens of different publications, or many buys for the same 
publication.  

make an insertion order for one 
selected space buy, or for all 
space buys on the print media 
plan.  One insertion order will 
be created for each publication.  

5  To print media reports, click 
on the print reports button.  To 
print a hard-copy printout of the 
print media plan, click on the 
print plan button.

6  Enter a print media plan 
number here to find a print 
media plan.  Or use the find 
more link to find print media 
plans by sequence, number, 
client, name/title, start date, or 
campaign.

7  Use the history pop-up menu 
to jump to a previously viewed 
print media plan.

8   Use the specifications link 
to view the print media plan’s 
details.    Use the vendor info 
link to view or edit the vendor’s 
address.  Use the delivery info 
link to enter special delivery 
instructions for the print media 
plan.  Use the periods link to 
view or edit the buy periods for 
the print media plan.

9  Print media plans are opened 
for a single client, just like a 
job ticket.  The client number 
will be copied from the media 
plan to insertion orders and, 
eventually, to media invoices.  

The name/title is a brief de-
scription of the plan’s objective, 
market, or product. It appears 
on the printed media plan, so 
clients see it.

Each print media plan is 
tracked by a unique media plan 
number. For easy tracking, each 
client has it’s own numbering 
sequence.  The media plan 
number is a combination of the 
client account number and its 
special media plan number.  A 
media plan’s number can’t be 
changed. 

The print media plans kind ap-
pears here for reference.  Print 
media plans can be created for 
three kinds of periods: daily (for 
newspapers), weekly (for weekly 
newspapers, trade journals, 
and weekly periodicals), and 
monthly (for magazines). Daily 
print media plans let you plan 
buys for a single seven-day pe-
riod. Weekly print media plans 
let you buy space for any twelve 
periods. Monthly print media 
plans let you place ads for up to 
twelve months.

10  A print media plan can be 
marked as closed after its buys 
have been ordered. Placing a 
print media plan on-hold makes 
it inactive, but keeps it open for 
future use. Closed and on-hold 
orders don’t appear on media 
status lists and traffic reports.  

11   The campaign and budget 
are displayed here for easy 
reference.  The optional budget 
can be used to show the 
amount expected for the total 
of the print media plan’s space 
buys.

12  The media plan’s space 
buys are listed here by publica-
tion code.  Double-clicking on a 
space buy displays its complete 
details, including the day, week, 
or month in which the ads will 
run.

13  The pub code and publica-
tion indicated the publication 
from whom you’re buying the 
space to run the ad.

14  Market shows where the 
space buy’s ads will run.

15  The ad number/caption 
identifies the ad on the printed 
media plan, insertions orders, 
and media invoices.  Any kind 
of description text or ID code 
can be used.

16  The ad’s gross cost (i.e., 
the amount the client will pay, 
including your commission) 
appears here for reference.  The 
ad’s net cost will be calculated 
using the gross cost and plan’s 
media commission.

17  An optional status can be 
used to track print media plans 
from start to finish using the 
same Status Table as jobs.
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Insertion/Broadcast/Interactive/Outdoor Orders
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Orders can be revised has many times as you want.  To make the first revision and 
start the revision counter, simply enter a “1” in the Description/Status window.  

u

a

1  Use the previous and next 
buttons to scroll through inser-
tion and broadcast orders.

2  Insertion and broadcast 
orders can be easily added, 
cloned, edited, or deleted.  
Click the add  button to add a 
new insertion order.  (To add 
a broadcast order, go to Edit 
> Add > Broadcast Order).  Or 
click on the clone  button to 
make an exact copy of an exist-
ing order.  Click the edit button 
to edit the order’s key details, 
such as the vendor, campaign, 

or brand.  Click the delete but-
ton to delete an order.  Once an 
insertion or broadcast order has 
been invoiced by the vendor or 
pre-billed to the client it can’t 
be deleted—even if it was only 
partially invoiced.  Like jobs, 
this feature prevents billable 
orders from being inadvertently 
deleted and, therefore, not 
billed.  Always let Clients & 
Profits X automatically number 
the next media order to avoid 
confusion from using the 
numbers of deleted orders over 
again. 

3  Click the add buy button to 
add new amounts to an order. 
The remove buy button deletes 
one or more selected costs 
from an order.  Only line items 
that haven’t been invoiced by 
the vendor or pre-billed to the 
client can be deleted. Once a 
line item is removed, it is gone 
forever:  its net cost and gross 
amounts are deducted from the 
job task permanently.  However, 
if needed, the same line item 
can be added back to the  order 
later.  
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Insertion orders and broadcast orders have separate preferences.  The agency name, address, disclaimer, 
auto-numbering, copies to names, and logo can be different. (This is especially useful for in-house agen-
cies that need to maintain a separate identity from the corporation in order to get agency discounts.)

4  Any insertion or broadcast 
order can be pre-billed using 
the pre-bill button.  Pre-billing 
automatically creates an invoice 
for the order’s gross amounts 
and shows the job and task 
like any other invoice.  The 
pre-billing invoice is unposted, 
so it can be proofed, posted, 
and then printed with other 
invoices.  There are two options 
available when pre-billing an 
order.  The show totals only 
option combines  all of the 
order’s amounts together, so 
that the invoice shows only 
one billing amount.  The show 
item-by-item detail creates a 
separate billing amount for 
every line item on the order.  
Also, the order’s billing can be 
added to an existing unposted 
pre-billing invoice by entering 
the number of the existing pre-
billing invoice into the pre-bill 
dialog box.  

5 The print reports and print 
order buttons are used to print 
insertion and broadcast order 
reports and forms.

6  If you know the insertion or 
broadcast order number you 
want to find, simply enter the 
number into the find order 
field.  Use the find more link to 
find one or more  insertion or 
broadcast orders by sequence, 
vendor, number, date, or job.

7  The history pop-up menu can 
be used to jump to a previously 
viewed insertion or broadcast 
order.

8  Use these links to edit the 

order’s description/status, 
vendor information, or options 
and to view  the vendor diary.  
The description/status window 
can be used to edit the order’s 
details, such as the campaign, 
brand, or status.  The vendor in-
formation window can be used 
to customize the vendor’s name 
and address on this insertion or 
broadcast order only.  The op-
tions window contains the cop-
ies to names and disclaimer for 
the insertion or broadcast order.  
The vendor diary window can 
be used to view, add, or edit 
diary entries for the insertion or 
broadcast order’s vendor.

9  Use the view>point pop-
up menu to view the order’s 
invoices.  

10  Every order has a unique 
number. New orders are 
numbered automatically, but 
custom, user-defined numbers 
can be entered instead.

11  The order date is the date 
the insertion or broadcast order 
was added. The client number 
does not show on the printed 
order; there is an option in 
Preferences to show the client 
name. The ordered by field 
shows the initials of the person 
who added the order. Insertion 
and broadcast orders can be 
printed in batches by user. The 
amount is the total amount of 
the  order’s line items.

12  The vendor’s name and 
address are copied to the order, 
but can be changed. This lets 
you send an insertion or broad-

cast order to a different address 
for the same vendor.  An order 
can include only one vendor; if 
you’re buying something from 
multiple vendors, each vendor 
gets its own insertion or broad-
cast order.

13  The due date shows 
when the buys are due to be 
delivered. The balance amount 
shows the amount remaining 
on the order that has not been 
invoiced to vendor invoices.  
When the insertion or broadcast 
order is closed, the balance 
amount will automatically 
change to $0.00.

14  The order will be closed 
automatically when applied to 
a payable for the full balance 
due.  If an order needs to be 
closed for any reason, click on 
the closed box.

15  The insertion or broadcast 
order’s  buys are listed here by 
line number.  Double-clicking 
on a media buy opens the Edit 
Media Buy window.

16  Some of the media buy’s 
details are listed here for easy 
reference.  For insertion orders, 
the media buy’s issue date, ad 
size, ad#/caption, space close 
date, materials due date, net 
cost, and gross cost will appear.  
For broadcast orders, the media 
buy’s broadcast month, market, 
ad name, product, materials 
due date, net cost, and gross 
cost will appear.

17 A lengthy description pro-
vides a detailed explanation of 

the order to the vendor.

18 Use the make goods link to 
add a make good to this inser-
tion or broadcast order.  Make 
goods are compensation for 
ads that either never ran or ran 
incorrectly.

19  The order’s current revision 
number increments auto-
matically each time someone 
edits the order.  To start the 
automatic revision numbering, 
a “1” must be entered into the 
revision box in the specifica-
tions window.

20  The status is user-defined 
note that describes the order’s 
current progress and appears 
on the printed order. Insertion/
Broadcast Order reports can 
be printed showing only orders 
with a certain status (i.e., on-
hold, change order, etc.). 

21  If an order has been ap-
proved, the approver’s initials 
and date appear on the Inser-
tion/Broadcast  Order window.  
Once approved, insertion and 
broadcast orders can’t be 
edited.  Only the user who ap-
proved the order can unapprove 
the order.   
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Adding Broadcast Orders
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Radio, cable, and broadcast tv spots ordered on behalf of a client should be tracked 
with broadcast orders.  They can be created one-by-one or from broadcast media plans.   
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1 The number identifies a 
broadcast order on windows, 
reports, and forms. Broadcast 
orders are numbered auto-
matically when added or when 
saved, based on your prefer-
ences.  Or, you can number 
your orders manually.  

2  Use the template pop-up 
menu to select a template.  
Choosing a template copies the 
template’s default details to the 
new broadcast order.  

3  An order has only one vendor 
which is usually the company 

that owns the station (or it 
might be the station itself).  
The vendor’s name and address 
appear on the printed broadcast 
order, but can be customized on 
each order.

4  The order date is the date 
on which the order was added. 
It appears on the printed 
broadcast order. Ordered by is 
the initials of the person who 
added the insertion order. Later, 
broadcast orders can be printed 
in batches by these ordered 
by initials. The commission is 

copied from the vendor, and is 
used to calculate the buy’s net 
cost. 

5  Every insertion order needs 
a job and task for accurate cost 
accounting.  The broadcast 
order’s cost will update the job 
task’s Net POs total.

6  The flight dates are when the 
programs will run. 

7  Campaign and brand are 
optional fields that are used by 
media analysis reports.
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Once the Add Broadcast Order window is saved, you can add media buys to the broad-
cast order.  Media buys contain the specific details about each spot that will run on the 
broadcast order.  A separate media buy should be added for each combination of run 
dates, times, and programs.  A broadcast order can have dozens of media buys on it.

8  The body of the broadcast or-
der is completely customizable. 
The standard field labels are 
designed for broadcast orders.  
The default labels are broadcast 
month, ad name, market, and 
product. Information added for 
these user-fields appear on the 
printed broadcast order. 

9  The materials due date is 
used by traffic reports and ap-
plies to first spot on the broad-
cast order. It can be customized 
for each media buy. 

10 The description field is a 
long text block. The label itself 
is customizable for flexibility. 
Any kind of notes or details 
can be entered here. This text 
appears in the heading of the 
printed broadcast order.

11  The special instructions 
field provide a space for details. 
It prints on the broadcast order 
below the line items.

12  The Media Buyer and 
Media Rep OK fields create 
approval lines on the printed 
broadcast or order along with 
the rep instructions.
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Adding Insertion Orders

Insertion orders are essential for accurate job costing.   They allow media costs to be 
committed to a job before the publication’s invoice is posted.  

1 The order number identifies 
an insertion order on windows, 
reports, and forms.  IOs are 
numbered automatically when 
added or when saved, based on 
preferences, or manually. 

2  Use the template pop-up 
menu to select a template.  
Choosing a template copies the 
template’s default details to the 
new broadcast order.  

3  An IO has only one vendor. 
It is usually the company that 
owns the publication (or it 

might be the publication itself).

4  The order date  is the date 
on which the insertion order 
was added.  It appears on the 
printed insertion order.

5  Ordered by is the initials of 
the person who added the inser-
tion order. Later, insertion or-
ders can be printed in batches 
by ordered by initials.

6  Every insertion order needs 
a job and task for accurate cost 
accounting.  The insertion’s 

cost will update the job task’s 
Net POs total.

7  The publication name is 
copied from the Publications 
table, which links the pub’s ad 
sizes with insertion orders.

8  The campaign code can 
be used to categorize media 
expenses. The brand name 
helps to identify the product 
line being advertised. Both are 
optional.

9  The issue date shows the 
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Any kind of ad space ordered on behalf of a client should be tracked with insertion or-
ders.  An insertion order can have one or dozens of different media buys for one vendor. 
Each media buy can specify a different ad to run, another set of run dates, or a special 
space buy for a certain ad and will appear as a separate line on the printed order.

week, month, or period of time 
each media buy runs. The 
ad/caption describes the spe-
cific advertisement that’s being 
run for this space buy.  The 
ad name/size is a combination 
of the ad/caption and ad size 
fields, but can be changed. It 
appears on media billings.

10  Space close is the date on 
which you must place this order 
with the publication. 

11  Materials due is the date 
on which the ad’s film, disk, or 
other materials must reach the 
publication.

12  Position is a customizable 
text field that can store notes or 
special instructions that appear 
on the printed insertion order.

13  Gross cost is the amount 
you’re charging the client for 
this ad. The commission is cop-
ied from the client, and is used 
to calculate the ad’s net cost. 
Net cost is the amount you’ll 
pay the publication for the ad. 

14  The bill net, not gross op-
tion lets you pass the ad’s true 
cost along to the client, without 
any agency commission.
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Adding Interactive Orders

Interactive orders can be used to buy advertising space on web sites, digital kiosks, 
point-of-sale locations—anything that’s electronic. 

Internet Advertising is are ads 
that appears on websites.  As 
the on-line population rapidly 
grows, so does the placement 
of ads on the world wide web. 
One advantage it has over 
traditional advertising is that 
enables clients to interact with 
the advertisement, so with a 
mouseclick anyone on-line can 
get more information about a 
product, subscribe for news and 
updates, or purchase it right 
then and there.  

1 The order number identifies 

an interactive order on windows, 
reports, and forms. Orders are 
numbered automatically when 
added or when saved, based on 
preferences, or manually. 

2  Use the template pop-up 
menu to select a template.  
Choosing a template copies the 
template’s default details to the 
new order.  

3  An interactive order has 
only one vendor, which is the 
company that owns web site or 
network.

4  The order date  is the date 
on which the interactive order 
was added and appears on the 
printed order.

5  Ordered by is the initials of 
the person who added the inser-
tion order. Later, orders can 
be printed in batches by these 
initials.

6  Every interactive order needs 
a job and task for accurate cost 
accounting.  The order’s cost 
will update the job task’s Net 
POs total.
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Internet ads also provides advertisers with an opportunity to precisely target its audi-
ence, enabling them to deliver advertisements that are customized to each consum-
er’s particular interests and tastes.

7  The website/network name is 
copied from the Publications/
Media Companies table, which 
links the media company’s ad 
sizes with interactive orders. 
The run dates show the days, 
weeks, or months the interac-
tive ad will appear on the site. 
The ad/caption describes the 
specific advertisement that’s 
being run for this space buy.  
The  banner size is the size of 
the ad in pixels. To see a list of 
ad sizes, leave the banner size 
empty then press tab.  A lookup 
list will appear listing the 
media company’s ad sizes that 
have been added into Publica-
tions/Media Companies table. 
You can then choose an ad size 
from the list or type in your own 
size. The linking URL indicates 
to the media company the web 
page should be opened when a 
viewer clicks on the ad. 

8  The campaign code can 
be used to categorize media 
expenses. The brand name 
helps to identify the product 
line being advertised. Both are 
optional.

9  The # impressions shows the 
number of time the ad will be 
seen by readers per month. It is 
used to calculate the ad’s cost 
per thousand (CPM).

10  Space close is the date 
on which you must place this 
order with the media company. 
Materials due is the date on 
which the digital artwork must 
reach the media company.

11  File size the media compa-
ny how large the digital artwork 
will be when it is sent.

12  Use special instructions to 

note any unique information 
or specific details about how 
this interactive ad should be 
run. They appear on the printed 
interactive order.

13  Gross cost is the amount 
you’re charging the client for 
this ad. The commission is cop-
ied from the client, and is used 
to calculate the ad’s net cost. 
Net cost is the amount you’ll 
pay the publication for the ad. 

14  The bill net, not gross op-
tion lets you pass the ad’s true 
cost along to the client, without 
any agency commission.
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Adding Outdoor Orders

Outdoor media orders are used to place any kind of out-of-doors advertising, such as 
billboards, mass transit signage, kiosks, building walls, and more.  

Outdoor advertising can reach 
a lot of people and build a 
strong identity within a local 
market.  Each board is assigned 
to a location, which displays 
it’s message to a percentage of 
the population. You can project 
your message on one or numer-
ous boards, to reach a total 
number of impressions that 
equal a percentage of the area’s 
population.

1 The order number identi-
fies an interactive order on 

windows, reports, and forms. 
Orders are numbered auto-
matically when added or when 
saved, based on preferences, or 
manually. 

2  Use the template pop-up 
menu to select a template. 
Choosing a template copies the 
template’s default details to the 
new order.  

3  Each outdoor order has only 
one vendor, which is the media 
company that owns or manages 
the billboard, signage, etc.

4  The order date  is the date 
on which the outdoor order 
was added and appears on the 
printed order.

5  Ordered by is the initials 
of the person who added the 
outdoor order. Later, orders can 
be printed in batches by these 
initials.

6  Every outdoor order needs a 
job and task for accurate cost 
accounting.  The order’s cost 
will update the job task’s Net 
POs total.
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The outdoor locations you buy most often can be added to the Publications/Media 
Companies table with specifications and rates, which will be copied to new outdoor 
orders automatically.  

7  The size/number identifies 
the specific ad space or location 
being ordered for this media 
buy. To see a list of the media 
company’s ad sizes/numbers, 
leave the field empty then press 
Tab. 

Illuminated indicates whether 
the outdoor advertisement is 
lighted and, if so, how many 
hours it is lit. The type/location 
describes the specific location 
that this advertisement will ap-
pear. Posting date shows when 
the media company will install 
or present the outdoor ad. 

8  The campaign code can 
be used to categorize media 
expenses. The brand name 
helps to identify the product 
line being advertised. Both are 
optional.

9  Materials due is the date on 
which the digital artwork must 
reach the media company.

10  Space close is the date on 
which you must place this order 
with the media company. 

11  Use special instructions to 
note any unique information or 
specific details about how this 
outdoor ad should be present-
ed. These notes appear on the 
printed outdoor order.

12  Contact term tells the 
media company how long (in 
months) this outdoor ad will 
run. It is the rate basis for the 
ad’s cost.

13  Monthly rate is the amount 
you’re charging the client for 
this ad per month. The commis-
sion is copied from the client, 

and is used to calculate the 
ad’s net cost. Total net is the 
amount you’ll pay the media 
company for the placement for 
the full contract term. Total 
gross is the total amount your 
client will pay for the ad’s entire 
run. 

14  The bill net, not gross op-
tion lets you pass the ad’s true 
cost along to the client, without 
any agency commission.

15  Special charges are op-
tional additional costs above 
and beyond the outdoor ad’s 
contract rate. They are one-time 
charges that are added to the 
total gross the client will pay. 
Special charges are commis-
sionable, so the net charge will 
be added to the orders’t total 
net.



5-30

Media Traffic

Media Traffic

The Media Traffic window gives media planners and buyers a one-stop place to check 
upcoming deadlines for space closings and materials due.  

1  Use the prev week and next 
week toolbar buttons to scroll 
through the four weeks of 
media deadlines available to be 
viewed.   

2  To print a hard-copy printout 
of the Media Traffic window, 
click on  the print report button.  

3  The Media Traffic window 
can list space closing and mate-
rial due dates for the next four 
weeks by using the show week 
pop-up menu.  Only one week 
can be viewed at a time.

4  The space closing list shows 
upcoming space deadlines 
from broadcast and print media 
plans. The space closing date 
can be entered separately for 
each buy on a media plan.

5  The materials due list shows 
upcoming traffic deadlines from 
actual insertion and broadcast 
orders.  
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Stations

Stations

1  Use the station toolbar but-
tons to add, edit, and delete TV, 
radio, and cable stations as well 
as print a station list.  

2  Use the time/program toolbar 
buttons to add, edit, and delete 
programs, times, and contract 
rates for the currently selected 
station.  You can also print a 
list of programs/times by click-
ing the Print button.  

3  Each station can have doz-
ens of different programs/times.  
You can set up standard rates 

for each program or time slot, 
as well as special program/rate 
combinations for each client.  
When a broadcast media plan 
is created, the right rate will 
be copied to the spot buy au-
tomatically.  Selecting a client 
from the pop-up menu displays 
that client’s special contract 
rates.  The program/times/rate 
table needs to be frequently up-
dated as the rates and programs 
change.  

4  Your stations are listed here, 
sorted alphabetically.  Clicking 
once on a station displays its 

programs/times and standard 
rates.  Double-clicking on a 
station ID opens the Stations 
window, where you can make 
changes to its details.  

5  The times/programs and 
standard rates for the selected 
station are listed here.  Double-
clicking a time/program record 
opens the Times/Programs/Con-
tract Rates window, where you 
can change the spot’s details.

Clients	&	Profits	keeps	a	detailed	table	of	the	stations	you	use	on	broadcast	media	plans.		A	broadcast	media	plan	is	com-
posed	of	different	spot	buys	for	a	two-week	period.		Each	program/time	is	added	as	a	separate	spot	buy	on	a	broadcast	
media	plan,	along	with	the	number	of	spots	that	will	run	each	day	of	the	flight.		When	you’re	adding	a	spot	buy,	you’ll	
select	a	station	from	the	Stations	lookup	list—which	links	the	media	buy	with	the	station’s	programs,	times,	and	rates.

The Stations window shows both your stations (television, radio, and cable) and their 
programs/times.  There’s no limit to how many stations and programs you can add.

e
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1  Each station must be as-
sociated with a vendor in the 
Vendor table. The vendor and 
the station can be the same, 
but must be added separately. 
One vendor can have many 
stations.

2  The station code is used for 
sorting and sub-totaling media 
buys on reports and client 
invoices, so clients will see 
it. Each station code must be 
unique.  The code is customiz-
able and user-defined.

3  The station’s name and 
address  are entered here and 
appear on printed media orders.

4  An ad rep for the station 
can be entered here with their 
phone number, and fax number.  

5  The commission rate will 
be copied to broadcast media 
plans when this station is used.

6  Any notes about the publica-
tion can be entered here.  They 
don’t appear on media reports.  

7  The publication’s market 
can be entered here for future 
reference.   

Anyone using Clients & Profits can see and update the station’s information, including 
the ad representative’s name, address, and phone number.
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Publications/Media Companies

The Publications/Ad Sizes/Media Companies window shows a detailed listing of all 
the publications and their ad sizes that you use for media print buying.  

1  Use these toolbar buttons to 
add, edit, and delete publica-
tions as well as print a publica-
tion list.  
Use these arrow toolbar buttons 
to change the sort direction the 
publications are listed in.

2  Use these toolbar buttons 
to add, edit, and delete ad 
sizes and contract rates for 
the currently selected publica-
tion.  You can also print a list 
of ad sizes/rates by clicking the 
print button.  Use these arrow 
toolbar buttons to change the 

sort direction the ad sizes  are 
listed in.

3  A publication can have 
dozens of ad sizes/rates.  You 
can set up standard rates for 
each ad size, as well as special 
size/rate combinations for each 
client. Selecting a client from 
the pop-up menu displays that 
client’s special contract rates.  

4  Your publications are listed 
here, sorted alphabetically by 
publication code.  To sort the 
list by publication name, click 

on the publication heading.  
Clicking once on a publica-
tion displays its ad sizes and 
standard rates.  Double-click-
ing on a publication opens the 
Publication window, where 
you can make changes to the 
publication’s information.  

5  The ad sizes and standard 
rates for the selected publica-
tion are listed here by ad size.  
To sort the list by gross cost, 
click on the gross cost heading.  
Double-clicking on an ad size 
opens the Print Ad Size window, 
where you can change the ad’s 
details.

t

Clients	&	Profits	X	keeps	a	detailed	listing	of	the	publications	you	use	for	media	print	buying	and	media	companies	
you	use	for	outdoor	advertising.		Each	pub	and	media	company	belongs	to	a	vendor	in	the	Vendor	table.		One	vendor	
can	have	dozens	of	publications,	each	with	its	own	collection	of	various	ad	sizes	and	rates.	
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1  Each publication/media com-
pany needs to be associated 
with a vendor in the Vendor 
table. The vendor and the pub-
lication/media company can be 
the same, but must be added 
separately. One vendor can have 
many publications.

2  The publication code is used 
for sorting and sub-totaling me-
dia buys on reports and client 
invoices, so clients will see it. 
Each publication code must be 
unique.  The code is customiz-
able and user-defined.

3  The commission rate will be 
copied to media estimates and 
print media plans when this 
publication is used.

4  The publication and media 
company’s name, address, 
phone number, and fax number 
are entered here and appear on 
printed media orders.

5  The publication’s issue date, 
close date, and circulation 
can be entered here for future 
reference.  

6  An ad rep for the publication 
can be entered here with their 
phone number.  It is optional, 
but appears on printed media 
orders.

7  The publication’s market 
can be entered here for future 
reference. The market is copied 
to orders added for this publica-
tion or media company.   

8  Any notes about the publica-
tion can be entered here.  They 
don’t appear on media reports.  

Anyone using Clients & Profits X can see and update the pub/media company’s infor-
mation, including the ad representative’s name, address, and phone number.
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Make Goods

Make	goods	are	compensation	for	ads	that	either	never	ran	or	ran	incorrectly.	
There	are	many	different	ways	a	print	ad	or	radio/tv	spot	can	be	compro-
mised,	providing	less	value	for	your	client.	For	example,	you	ordered	for	a	
guaranteed	position	in	a	magazine,	but	the	ad	actually	ran	in	a	different,	less	
desirable	place.		Or,	you	placed	a	radio	spot	to	air	during	a	certain	show,	but	
the	ad	ran	during	a	different	program.	In	these	situations,	the	publication	or	
station	will	either	offer	to	run	the	ad	or	spot	again,	credit	the	entire	amount	
of	the	ad’s	cost,	or	issue	a	partial	credit.	

Make	goods	need	to	be	added	
to	the	original	insertion	order	
or	broadcast	order	so	that	the	
shop’s	job	costing	is	accurate.	
If	make	goods	aren’t	entered	
as	they	happen,	your	job	costs	
won’t	match	up	with	your	com-
mitments.

It’s	the	media	buyer’s	respon-
sibility	to	match	the	station’s	
affidavits	or	the	publication’s	
tear	sheets	to	verify	that	the	
ads	or	spots	that	actually	ran	
match	what	the	shop	ordered.	
Any	discrepancies	needs	to	be	
noted	on	the	client’s	broadcast	
or	insertion	orders	by	adding	
make	goods.	

Make	goods	are	simply	additional	media	
buys	appended	to	an	insertion	order	or	
broadcast	order	after	the	ads	or	spots	
have	been	run.	They’re	functionally	no
different	from	an	order’s	regular	media	
buys—each	make	good	line	item	includes
details	about	the	dates,	times,	programs,	
etc.	of	the	affected	print	ad	or	radio/tv	spot.	
Make	goods	will	have	a	negative	cost	amount	
if	the	station/publication	is	offering	a	credit;	
otherwise,	free	make	good	ads	will	have	a	no	
cost	at	all.

When	make	goods	are	added,	they	update	the	job’s	commitment	totals	just	
like	the	original	order.	They	appear	on	media	reports	just	like	other	media	
buys.	When	the	station	or	publication	media	invoice	is	added	into	Accounts	
Payable,	they	are	reconciled	along	with	the	order’s	original	media	buys.

To add a make good for a broadcast order

1		From	the	Insertion/Broadcast	Orders	window,	find	the	broadcast	order	that	
needs	the	make	good.

2		Click	once	to	highlight	the	media	buy	wasn’t	run	or	run	incorrectly.

3		Click	the	 	link	or	choose	Edit	>	Add	Make	Good.

The	Add	Broadcast	Make	Good	window	opens,	prompting	you	to	enter	the	
make	good’s	details.	The	media	buy’s	details	are	copied	to	the	make	good	
line	item	except	for	the	date,	time,	and	program.

4		Enter	the	dates,	days,	time,	
and	program	for	which	this	
make	good	spot	will	run.

The	dates,	days,	etc.	is	based	
the	compensation	negotiated	
with	the	station.

5		Enter	the	rate,	spots,	
amounts,	and	other	details	
for	this	make	good,	then	click	
Save.

To add a make good 
for an insertion order

1		Find	the	insertion	order	
that	needs	the	make	good.

2		Click	once	to	highlight	the	

media	buy	wasn’t	run	or	run	incorrectly,	then	click	the	 	
link	or	choose	Edit	>	Add	Make	Good.

3		Enter	the	issue	date,	ad	caption,	and	ad	size	for	which	this	make	good	ad	
will	run,	based	the	compensation	negotiated	with	the	publication.

4		Enter	the	space	close	and	materials	due	dates	for	this	make	good,	then	
click	Save.

Reprinting the revised broadcast or insertion order

Once	the	make	good	is	saved,	the	broadcast	or	insertion	order	can	be	
reprinted	and	faxed	to	the	station,	if	necessary.	For	clarity,	the	reprinted	order	
will	show	the	original	media	buys	plus	the	make	goods.

1		Choose	File	>	Print	Orders	then	follow	the	prompts.

Editing a broadcast media 
buy.  Broadcast orders are 
added, edited, revised, 
printed, and billed like pur-
chase orders and insertion 
orders. Dozens of separate 
media buys can be added 
for the same station on a 
broadcast order.
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Media Billing Goals

The	Media	Group	Performance	-	Trend	Analysis	report	compares	actual	media	spending	for	each	kind	of	media	(e.g.,	
broadcast	TV,	radio,	etc.)	with	the	media	department’s	billing	goals.	For	these	reports	to	work	properly,	the	shop’s	
billing	goals	for	each	media	kind	must	be	entered	in	the	Media	Goals	window.	Media	billing	goals,	which	are	based	on	
gross	amounts	on	broadcast	and	print	insertion	orders,	can	be	entered	for	each	quarter	of	the	calendar	year.	

These media billing goals can be edited any time. They are used only for media reports, 
and don’t affect job tickets, media plans or estimates, job costing, or the General Ledger.
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The Media Billing Goals window 
allows the agency to  record 
media spending goals per 
media type, per fiscal  quarter, 
and also calculates a total for 
each media type,  quarter, and 
year-to-date. In media analysis 
reports,  these amounts are 
measured against actual gross 
amounts  derived from media 
spending.

1  Click print to get a report of 
the year’s billing goals by media 
kind and quarter.

2  The media kind is used to 
categorize different types of 
media (e.g., tv, radio, news-
paper, etc.) and is a vendor 
setting. When media perfor-
mance reports are printed (see 
Snapshots > Media), C&P X 

will summarize media billings 
by vendor, sub-totaling by the 
vendor’s media kind setting.

3  Enter the billing goals for 
each kind of media for each 
quarter of the year.

4  The quarterly and media kind 
totals are calculated as you tab 
between fields. 
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Media Reports

Clients	&	Profits	prints	two	kinds	of	media	reports:	status	and	traffic.	Status	
reports	are	used	by	media	buyers	and	the	media	department	to	track	open	
media	plans,	media	estimates,	media	deadlines,	and	unbilled	media.	Traffic	
reports	allow	you	to	see	the	scheduled	buys	based	on	space	closing	and	
materials	due	dates,	which	are	entered	for	each	line	item	on	a	media	plan	or	
estimate.	

To print media reports

Media	reports	can	be	
printed	from	the	Media	
Estimates,	Broadcast	
Media	Plans,	or	Print	
Media	Plans	windows.

1		Choose	File	>	Print	
Media	Reports.

Media	reports	are	
grouped	together	by	
category	(i.e.,	Status	or	
Traffic).	Each	category	
has	a	collection	of	
media	reports	that	can	
be	printed.	Only	one	
report	can	be	printed	at	
a	time.
	
2		Select	a	report	
category	to	show	the	
reports	that	can	be	
printed.	

3		Choose	a	report	by	clicking	on	
a	report	name.

4		Enter	a	range	of	dates	and	
select	any	available	options.

Status	and	traffic	reports	are	
based	on	media	plans	and	
media	estimates,	so	the	date	
range	entered	will	select	
plans	or	estimates	based	on	
the	date	they	were	added.

5		Click	Print.

■		Any	print	or	broadcast	media	plan	that	is	marked	as	“closed”	or	“inactive”	
will	not	be	included	on	media	status	reports	or	media	traffic	reports.

Media Reports

Media reports help different 
departments manage clients.  
Status and traffic reports track 
the day-to-day media plans and 
estimates. Post-buy reports help 
media buys track what’s been 
ordered. Account service can use 
client spending reports to analyze 
each client’s media spend-
ing. Group performance reports 
summarize how well the media 
department manages spending 
trends, client media profitability, 
and spending volumes.
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Media Reports

Media Estimate List 

Media Estimate Status Report 

Media Plan List

Media Plan Status Report 

Unbilled Media

Client Media Calendar

Space Closings

Material Due

Media Job List

The Media Estimate List lists all media estimates for a range of dates.

The Media Estimate Status Report lists open media estimates sorted by status, which is 
user-defined.

The Media Plan List prints all broadcast media and print media plans for a range of dates.

The Media Plan Status Report lists open broadcast media and print media plans sorted by 
status, which is user-defined.

The Unbilled Media Report lists all insertion orders and broadcast orders that have not been 
billed to the client. The orders are grouped by client and sorted by order number.

The Client Media Calendar lists media buys by billing period, which is based on your ac-
counting periods. Media buys are grouped by client, then subtotaled by month. The month’s 
media buys are then sorted by close date and issue date. Each media buy shows its publica-
tion, issue date, ad name, ad size, space closing date, and materials due date.  

The Space Closings Reports lists the selected space closing dates of media estimate buys, 
sorted by media buyer and date. It can be printed for planned or ordered media buys.

The Materials Due Reports lists the selected material due dates of media estimate buys, 
sorted by media buyer and date. It can be printed for planned or ordered media buys.

The Media Job List shows the job number, job name, AE, job due date, status, and status 
note for each job with a media estimate, and sorts it by client. 

Status Reports

Traffic Reports
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Media Link imports broadcast orders, print insertion orders, and vendor invoices into 
Clients & Profits from media buying system that support the Standard Media Interface.  

u

Media buying systems that sup-
port SMI export media orders 
from media plans into specially-
formatted text files, one for 
each broadcast order, insertion 
order, or vendor invoice. These 
files the order details (e.g., 
station ID, run dates, number 
of spots, rating, cost, etc.) or 
invoice needed by Clients & 
Profits X for job costing, billing, 
and media accounting.

How it works:  A media buyer 
enters broadcast orders, inser-
tion orders, and vendor invoices 
into SmartPlus, TAPSCAN, or 

Strata. The media buying sys-
tem exports a copy of the order 
or invoice into a designated 
media_buys folder on your file 
server. The Media Link looks 
for these media buy files then 
imports them into your C&P X 
database as broadcast orders, 
insertion orders, or vendor 
invoices—just as if you’d typed 
them in yourself. These orders 
can be billed to clients just like 
any other media order. Imported 
invoices appear in Accounts 
Payable.

1  Clicking import tells C&P 

X to look for any export files 
inside the media_buys folder 
then import them.

2  Click the clear log button to 
erase the Media Link activity 
log. Clearing the log deletes the 
entries permanently.

3  Click the print button to get 
a hard-copy report of the Media 
Link’s log entries.

4  The database name is 
shown for reference. If you use 
multiple databases, be sure 

The	Media	Link	imports	broadcast	orders,	print	insertion	orders,	and	vendor	invoices	into	Client	&	Profits	X	from	lead-
ing	media	buying	systems,	including	SmartPlus,	TAPSCAN,	Strata,	and	other	systems	that	support	the	Standard	Media	
Interface.	.
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Media Link really pays off when you’re buying large amounts of broadcast or print me-
dia. Rekeying dozens of buys each week into Clients & Profits would be tedious and 
probably error-prone. There’s no double-entry and no missing data.

to double-check the database 
name—otherwise you might im-
port media buys into the wrong 
database.

5  The Media Link Log tab 
displays your recent activity. 
Each time an order or invoice is 
imported, a log entry is created. 

6  The Preferences tab (see 
right) offers settings and op-
tions that let you control how 
some parts of 
the Media Link will behave. 
These settings let you turn on 
and off certain functions.

7  For each imported order 
you’ll see the date/time it was 
imported, the order number (as 
entered into the media buying 
system), the initials of the 
person who imported the order, 
and the order’s import status. 
The status notes any problems 
with the imported media order. 

1  Click the Preferences tab to 
edit the Media Link’s options 
and settings. The changes you 
make are saved automatically 
and take affect immediately.

2  Choose your media buying 
system from the import media 
buys from pop-up menu.

3  If you bill a different com-
mission rate than that in your 
media system, select “Clients 
& Profits” from the use BO or 
IO commission from checkbox. 
This is usually done if you bill 
at a lower commission than 

the standard 15%. The gross 
amount will be recalculated 
during the import using the 
commission rate entered in 
client’s Billing Info window.

4  If your shop doesn’t charge 
media commissions to clients, 
check the always bill net op-
tion. This forces all imported 
orders to be billed at net cost 
instead of gross cost. But make 
sure your media buying system 
is not already exporting at this 
lower gross cost, otherwise you 
will incorrectly reduce your 
billing amount if you choose to 

use the Clients & Profits com-
mission rate.  If it is already 
exporting the gross cost at the 
lower commission then leave 
the setting at your media buy-
ing system.

5  Uncheck the enable log op-
tion if you don’t need to record 
the Media Link’s activity.

6  Use the notify option to send 
an e-mail to any staff member 
(such as a bookkeeper) when-
ever a new order or invoice is 
imported automatically. 

Media Link imports media buys from leading media buying systems, such as Smart-
Plus, Strata, TAPSCAN, and other systems that support the Standard Media Interface.
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